Introduction

The aim of this document is to show you how to make the best use of Microsoft Word when writing a thesis. It's important that you use certain features, right from the first paragraph. These then make it much easier to bring all of the component parts of a thesis together and allow you to produce things like a Table of Contents or List of References automatically. This document assumes you are reasonably familiar with Word. See the documents Microsoft Word: An Essential Guide and Microsoft Word: An Intermediate Guide if you are not. You may also need to work through some of the Advanced Wordprocessing Topics.
The Rules and Page Setup

The Rules for the Submission of Theses for Higher Degrees specify the required format for a thesis (see Sections 4 and 5). They are published at [www.reading.ac.uk/Exams/ThesesRules.pdf](http://www.reading.ac.uk/Exams/ThesesRules.pdf). In brief, they state:

- The length should not exceed 90,000 words (for a PhD) or 60,000 (for an MPhil)
- The paper size must be A4 (30cm x 21cm)
- The text should be spaced to ensure legibility (ie one-and-a-half or double spaced)
- The left (binding) margin should be at least 35mm, with the other margins at least 15mm
- The margins should not include the page number
- Pages containing any table etc must be numbered in sequence with the rest of the thesis
- Printing should be on one side of the paper only, except where a table, graph or illustration faces text to which it refers (these can also be placed in a pocket at the back of the thesis)

There's further information about the contents of the title page and what to do with other material such as maps and CDs, which can't be bound with the text.

**Note:** Some schools/departments have their own rules – ask your supervisor about these.

To comply with the Rules, the following changes should be made to the Page Setup:

1. Start up Microsoft Word as usual, beginning with a new document
2. Move to the PAGE LAYOUT tab on the Ribbon and click on the [Page Setup] group arrow (on the far right of the Page Setup group heading) - the following dialog box appears:

   ![Page Setup Dialog Box](image)

3. On the **Margins** tab, check that the **Top** and **Bottom** margin are set to at least 1.5cm - the default settings of 2.54cm (one inch) are fine
4. Adjust the **Left** margin to at least 3.5cm and check that the **Right** margin is at least 1.5cm

**Tip:** To keep the overall typing area the same as other documents, increase the **Left** margin by (for example) 1 cm to 3.54 cm and decrease the **Right** margin by a corresponding amount to 1.54cm.

5. Click on the **Paper** tab and check that the **Paper size** is set to A4 - if it isn't, change it
6. Click on the **Layout** tab and under From edge: increase both the **Header** and **Footer** to 1.5cm to accommodate any page numbering etc

Note the [Set As Default] button on this and the other tabs. If you click on this it will affect all your new documents.

7. Press <Enter> for [OK] to close the Page Setup dialog box
Saving your Thesis

It’s a good idea to create a special folder in which to store all your thesis work:

1. Press <Ctrl s> (or move to the FILE tab and choose Save) then click on My Documents
2. Click on the [New folder] button on the Save As window toolbar
3. For the Name: of the New Folder type Thesis then press <Enter> twice to rename and Open it
4. Supply a File name: (eg Chapter1) for your file - press <Enter> for [Save]

Note: If you want to be able to open your file with an older version of Word, turn on the option to Maintain compatibility with previous versions of Word at step 4.

Your file is now called Chapter1.docx, as shown at the top of the screen. However, there are various other settings you should change before you use it to type your work.

Setting up Styles

By far the most important feature provided in Word, which you should be using when writing a thesis, is styles. Styles are simply different types of formatted text and include settings such as font, font size, bold/italic/underline, justification, numbering and paragraph spacing. It’s much better to use them rather than setting up a particular format manually for several reasons:

- You don’t have to keep clicking on the Ribbon buttons to activate and de-activate the settings
- If you alter a style, text defined in that style changes throughout the whole document
- You can create your own styles

Even more important, for a thesis, are heading styles. They are useful for four main reasons:

- You don’t have to remember how different section and sub-section headings are set up
- Word can number your headings automatically and you can cross-reference them in your text
- You can use the Navigation Pane to easily move around your document
- And, vitally, heading styles are used to generate a Table of Contents

The first of these points ensures all your headings look the same, no matter which chapter of your thesis you are editing. If you decide you don’t like the way that the headings look then you can just redefine the style and all your headings will be redrawn. The Navigation Pane lets you move directly to any heading without having to scroll up and down to find it.

The final reason is even more important. If you don’t use styles for your headings then you can’t generate a Table of Contents automatically. Instead, you will have to go through your thesis to work out which page each section or sub-section is on and then manually type in the table. This can be very time-consuming and inaccuracies inevitably creep in. And you have to check it all again if you make any changes.

In Microsoft Word you have different heading styles already set up for you (but, as you will see later, you can easily redefine these if you want to use a different font, font size or paragraph spacing/justification etc):

1. On the HOME tab, on the Ribbon, note the Styles group towards the right
2. Click on the [Heading 1] button for a title in a larger font and bold – the Navigation pane appears
3. Type the title of your work - eg Chapter One - Introduction
4. Press <Enter> and you automatically revert to the Normal style of text

You may have noticed that Heading 1 is a slightly different font (Calibri Light) to Normal text (Calibri). This makes the heading stand out but you might not like it or might prefer a different font completely. You might also prefer a different font size or colour. It’s easy to redefine the style as follows:

5. Right click on the [Heading 1] button in the Styles group and choose Modify...
6. Change the font, font size, colour, justification, bold etc to what you prefer - eg [Center] it, make it [Bold] and change the [Font Color] to Automatic (ie black)
7. Click on [OK] to close the Modify Style dialog box

**Note:** It's important that you redefine styles like this rather than manually format the text. This is particularly important if you are using your own PC and have *Keep track of formatting* turned on. With this on, a new style is created each time you manually format a paragraph (and you end up with hundreds of styles). To check this option is turned off, move to the **FILE** tab then click on **Options** and choose **Advanced** – *Keep track of Formatting* is one of the **Editing options** and should not be ticked on.

**Numbering Headings**

The default heading styles do not include any numbering. If you want your sub-section headings numbered (eg 1.1, 1.2 etc) then you need to use a **Multilevel list**. An added benefit is that it lets you include the chapter numbers in your page numbering and figure/table captions (eg Table 1-1 if that’s what you want).

1. Click anywhere on your main heading (to reset the typing position) then on the **Multilevel List** button – the third in the top row of the **Paragraph** group on the **HOME** tab of the Ribbon.

2. From the **List Library**, select the numbering style required (choose one associated with heading styles - the right one in the middle row is a good choice) – your heading is now numbered.

To customize this further:

3. Click on the **Multilevel List** button again but this time choose **Define New Multilevel List**...

4. In the dialog box which appears, click on [More>>] to see all the available options:

You will see that you have 9 pre-defined heading levels, which gradually build up the numbering from one level to the next. Word lets you customise the **Number format** - for example you could add the word **Chapter** before it, as you’ll see next:

5. Click in the **Enter formatting for number**: box then press the `<Home>` key (to move the typing before the shaded number 1) and type **Chapter** (+ a space) – note how the style appears in preview above.

Note that **Number style**: (immediately below **Enter formatting for number**) for each level allows you to choose different numbering (eg i, ii, iii or **One**, **Two**, **Three**), but this then feeds down to the next numbering level. You probably won’t want **One.1.1**! Note also [Font...], which allows you to set the font characteristics for the numbering, such as its size or bold/italic. Ignore **Start at**: - you’ll see later how to number each chapter.

6. Headings sometimes wrap onto a second line – set **Text Indent at**: to **0cm** to line them up on the left.

7. Click on **Set for All Levels**... to apply this setting to all the other heading levels – press `<Enter>` for **[OK]** to verify this.
By default, a tab character separates the numbering from the rest of the heading, which can cause problems. It’s better to have a space (or a hyphen or colon). You can change this as follows:

8. Using the list arrow provided, change the option Follow number with: to Space - if you want a different character (eg a hyphen), choose Nothing then add the character to the Enter formatting for number

9. Repeat step 8 for the other heading levels by first selecting them from the Click level to modify: list

10. Press <Enter> for [OK] to enforce your changes and close the Define new Multilevel list dialog box

11. End by deleting the excess words Chapter One from your title - take care not to delete the space following the numbering (use [Undo] if you go wrong)

Your heading style has now been reset. Next time you use it, it will have the new characteristics. Note that if you don’t want a particular heading numbered but want it to appear in the Table of Contents, simply turn off the numbering for that heading (by clicking on the <Numbering> button) but keep the Heading style on.

**Warning:** Avoid using more than one multi-level list as this causes problems when you bring your chapters together.

**Tip:** If you would like Chapter 1 to appear on a separate line above the rest of the heading, click on the heading then press <Home> followed by <Shift Enter>. This gives you a new line but not a new paragraph. Also use <Shift Enter> whenever you want to split a long heading at a particular place. The extra line is not passed through to the Table of Contents (but you can edit the entry in the ToC in a similar way).

### Sub-Headings

Now that you’ve set up your numbered headings, it’s time to see them in action.

1. Press <Ctrl End> to move to the end of your text

2. Type in an initial paragraph (a couple of lines of rubbish text will suffice) then press <Enter>

Currently, only a few styles are showing; to see the other heading levels you can either use the scroll bar attached to the styles (on the right) or the More button below this or the Styles group arrow:

3. Click on the [Styles] group arrow on the far right of the Styles group heading – a Styles window appears

4. To fix this in position, double click in the area at the top – it’s now a pane on the right of the window

5. Choose [Heading 2] – you’ll find your paragraph is automatically numbered 1.1

6. Type some text as a heading then press <Enter> - the style again reverts to Normal

7. Type in another normal paragraph (a couple of lines is sufficient) then press <Enter> again

8. Repeat steps 5 to 7 except choose Heading 3 to see how this style has been set up

**Tip:** You can also set heading levels by choosing any heading level and then pressing <Tab> to move down or <Shift Tab> to move up through the levels. To change the level for an existing heading using this method, the typing position must be at the start of the heading – press <Home> before using <Tab> or <Shift Tab>.

If you don’t like the way the default Heading 2 and Heading 3 styles are defined then you can redefine the styles as you did previously for Heading 1 - for example, you might prefer your headings to be in a slightly different or larger font:

9. Right click on [Heading 2] in the Styles pane and choose Modify...

10. Select the required font characteristics – eg set the font size to 14, color to automatic and turn on bold

11. Click on [OK] to close the dialog box

Another way to do this is to make the changes to an existing heading and then set that as the style:

12. Click three times on the Heading 3 heading to select it (the numbering isn’t highlighted)

13. Set the required font characteristics (eg Bold and Automatic font colour) using the buttons in the Font group of the HOME tab on the Ribbon or by right clicking on the selection to see a local copy of these

14. Right click on Heading 3 in the Styles pane or on the Ribbon and Update Heading ... to Match Selection
The Body Text (*Normal Style*)

Your ordinary paragraphs are known as the *body text*. The current *Normal* style doesn't meet the criteria specified in the *Rules* and needs to be changed. These stipulate that the text should be spaced legibly and suggest one-and-a-half or double spacing. Most theses seem to be double-spaced but you can reduce the spacing if you think that looks better. Indeed, any spacing which is at least one-and-a-half would seem to be acceptable (you can make use of this to fit your text neatly onto the pages). You may also need to customise the font and font size. Some departments insist on particular fonts; if they don't, the choice is yours.

1. Right click on the *[Normal]* button in the *Styles* pane and choose **Modify**...
2. If you don't like *Calibri*, select a different *Font* from the list provided
3. If you prefer a different *font Size*, select one from the list or type in the value

Next you need to set up the line spacing and justification:

4. Set the *Alignment*: some people like to *[Justify]* text; others prefer to keep *[Align Text Left]*
5. Change the *Line spacing*: to **Double** (or **1.5 lines** for *one-and-a-half* spacing)

**Tip:** If you want your lines somewhere between one-and-a-half and double spaced, change this to **Multiple At**: (for example) 1.8.

Note how all your paragraphs (including the headings, which are based on the *Normal* style) have been reformatted (eg double spaced) automatically.

Page Numbering

Another setting you can save in your file is the page number - its position and format. To add a page number to your work:

1. Move to the *INSERT* tab on the *Ribbon* and choose *[Page Number]* in the *Header & Footer* group
2. From the list which appears, choose whether you want the numbers at the *Top of Page* or *Bottom of Page* and then select from the formats available (*Plain Number 1 to 3* are best)

The page number now appears in either the *Header* or *Footer* and an extra *HEADER & FOOTER TOOLS* tab appears on the *Ribbon*. Note that the *[Page Number]* button is repeated here in the left group. If you want to change the format of the page number:

3. Click on the *[Page Number]* button and select **Format Page Numbers**... - the following dialog box appears:

   ![Page Number Format Dialog Box]

   You probably won't need to change any of the settings here - just note what you can do. *Number format*: lets you choose Roman numerals (*i, ii, iii* ... for example) - you may need to use these when you come to write your introductory pages (table of contents/figures, acknowledgements etc). *Include chapter number*: lets you add this to your page numbering (eg 1 - 10), which solves the problem of setting a fixed page number for subsequent chapters. *Start at*: lets you set the number for a particular chapter if you want to.
Tip: If you start at: 0 and also set a [Different First Page] (in the Options group on the DESIGN tab) then numbering appears to start on the second page - useful if you don't want a title page numbered.

4. Press <Enter> for [OK] to close the Page Number Format dialog box

Headers and Footers

You might want a special header or footer, showing the main title of your thesis, for example. This isn't generally the case but you may want the title of each chapter to appear. As such, you set this in each chapter. To maintain consistency across the chapters, however, you might want to change the Header style:

1. Click on the [Header] button (on the far left of the HEADER & FOOTER TOOLS tab) and choose Blank

Tip: Don't be tempted by the fancy headers which have a box labelled [Type the document title]. This is a special property of a file and can't easily be reset for the different chapters. If you want a horizontal line then add it later via the [Borders] button on the HOME tab (and format the line if you want a fancy one).

2. In the [Type text] box, type Introduction

3. Press <Ctrl e> (for [Center]) or <Ctrl r> (for [Align Text Right]) if you want to alter the text position

4. Double click on the word Introduction then make any font changes (eg size, bold/italic) you require

5. Next, right click on the Header style in the Styles pane and Update Header to Match Selection

6. When you have finished, either double click anywhere in the main body of the text or use the [Close Header and Footer] button on the far right of the HEADER & FOOTER TOOLS tab

7. Finally, press <Ctrl s> to save the changes to your file

Note: You might also want to change the Footer style to match (or to another format).

Keeping your Work Safe and Secure

A thesis is a very important piece of work. It's vital that you save it in a safe place and make regular backups of any files. If you are working on a University Lab PC and saving your files in My Documents then you can be assured that your work is safe and that it will be backed up regularly. It's a good idea to keep all your thesis files in the one folder. It's then easy to find a file or make a backup of the whole folder (and any sub-folders).

Tip: It's a good idea to keep each chapter in a separate file. If you do manage to delete a file (or it becomes corrupt) and haven't got a backup then at least you only lose the one chapter. It's also better for Word to work with smaller files rather than one big one (the possibility of corruption increases significantly with file size, particularly if charts and pictures are included).

If you are working on your own PC then always store your files on the hard disk. As here, save your files in a special folder within My Documents. USB pens and similar multimedia can be used for moving files from one computer to another or for taking backups of files, but AVOID WORKING DIRECTLY FROM SUCH MEDIA. Another safe place to store your work is in the Clouds – you can then access it from any computer, worldwide.

If you are using your own PC, it's vital to make regular backups of your work. Don't rely just on a single backup as it's possible for the current version of a file on the hard disk to be corrupted in saving. You might then copy this onto your backup media, overwriting the only good copy of your file. Work on a grandparent/parent/child system, replacing the oldest (grandparent) version each time.

Be aware that no backups on multimedia can be considered 100% secure. It's all too easy to damage the media or they can become corrupt. They can also be stolen or damaged by fire or liquids, as can your PC. If you can, keep an extra backup in another location (eg at your parents' or a friend's house) then that provides additional security. Better still, make use of the University system to back up your work - bring your backup media onto campus (or attach your files to emails) and then copy them to My Documents on your N: drive.

Tip: If you are moving your files between your own PC and the University system, it's important to label your media with your contact details so that if they're left behind, it's possible to trace the owners.
Typing the Text

You can now continue writing your *Chapter 1*. Don’t waste time trying to fit your work onto the pages until you have finished amending and correcting it. This is dealt with in *Microsoft Word 2013: Finishing a Thesis*.

Creating More Styles

As you type, you may find that you need to create new styles (or amend existing ones) and this you can do from within a document. To see how, try typing a bulleted list:

1. Check you are at the end of your work on a blank line (with the style set to *Normal*)
2. Click on the [Bullets] button, type in a short line of text then press <Enter>
3. Repeat step 2 for a second bulleted list item

You may consider that your list is spaced too widely. To amend the style:

4. Right click on the *List Paragraph* style in the *Styles* pane and choose *Modify…*
5. Click on [Format] and choose *Paragraph…*
6. Set *Line spacing:* to **1.5 lines** to squash up your text a little
7. Check that the *Don’t add space between paragraphs of the same style:* option is turned on
8. Increase *Spacing After:* to **16 pt** to balance the gap between the last item and following paragraph then press <Enter> for [OK] to close the *Paragraph* dialog box
9. Press <Enter> for [OK] to close the *Modify Style* dialog box – your list should look much better
10. Press <Enter> to end the list
11. Type in a normal paragraph (a couple of lines is enough)

**Note:** This will also squash up numbered lists as they too use the *List Paragraph* style.

Next, try creating your own style for a table. First, insert a table to see how it could be improved:

1. Move to the *INSERT* tab on the *Ribbon* and click on the [Table] button
2. Select a small table (2 rows by 3 columns would be sufficient)
3. Type some headings in the cells in the first row then a couple of lines of text into the first cell of row 2

As with the numbered list, the text is very widely spaced – this can prove problematic in a table where you may want to store as much information as possible in a limited space. Note also that the text isn’t centred very well vertically – it touches the top border of the cells but there is a gap below the text and bottom border. To rectify this:

4. Click on the [New Style] button (the first button in the bottom left corner of the *Styles* pane)
5. **Name:** the style **MyTable** (or something similar)
6. Click on [Format] and choose Paragraph...
7. Change the Line spacing: to 1.5 lines and change both Spacing Before: and Spacing After: to 6pt
8. Press <Enter> for [OK] twice to accept the changes
9. Select the whole table then click on MyTable at the top of the Styles pane to apply it to the other cells

Your table should look much better and you’ll be able to squeeze much more into tables using this style. You’ll need to select it each time you create a new table (or reformat an existing table), as in step 9 above.

**Tip:** Tables are often too wide to fit on an upright page but having landscape (sideways) pages in the text can be problematic. To get round this, create them on a landscape page then take a Screenshot of the table and place it on an upright page. Screenshots are pictures which can easily be rotated sideways to fit on the page.

### Adding Graphics

In the same way that heading styles are used to generate a Table of Contents, Captions are used to generate a List of Figures etc. These are another special style, which you can customise if you want. Whenever you add a line of text above (or below) a figure or table etc, you must use the caption style for this. It’s best if you insert the figure first, and then add the caption:

1. Press <Ctrl End> to move to the end of your work

You would now usually go to the INSERT tab and click on [Picture] (for a picture) or [Object] then Create from File and [Browse...] to find the file. Note that if you use the Link to File option, you must make sure the linked file isn’t moved or renamed. Here, however, let’s simply insert a screenshot:

2. Move to the INSERT tab and click on [Screenshot] then choose Screen Clipping

The screen switches to the window previously viewed (here, the Desktop)

3. Using the mouse, hold down the mouse button and draw out a rectangle to cover the area required

4. Release the mouse button and the screenshot will be inserted in your work

5. Resize (and crop) the picture, if necessary, using the handles provided (and [Crop] button)

**Tip:** By far the best method to paste an Excel chart is as a picture - use Paste Special... then Picture (a JPEG or GIF are fine). This can then be rotated, if necessary, to create a sideways chart on an upright page. Pictures have the advantage that they do not change when resized. If you need to make any changes, do so in Excel and then copy the updated chart back to your document. Before copying the chart from Excel, place it on a separate chart sheet – this minimizes the space used by the legend and axis labelling.

### Adding Captions to Figures, Equations, Tables etc

It’s now time to add a caption to the figure.

1. Make sure your figure is selected (ie it should be surrounded by handles) before you add the caption

2. Either right click on the figure and choose Insert Caption... or move to the REFERENCES tab and click on [Insert Caption] - the following window appears:
The default caption is for a Figure but other captions are available (or you can create your own).

3. Using the list arrow attached to Label: select the type of caption required (here, Figure is fine).
4. To create a different label, click on the [New Label...] button.
5. Type in your Label: (eg Photograph) then press <Enter> for [OK].
6. Reset the Label: to Figure as in step 3.
7. Using the list arrow attached to Position: select whether you want the caption above or below then press <Enter> for [OK].

The [Numbering...] button lets you change the numbering system (eg to Roman numerals) and you can include the chapter number if you wish. With [AutoCaption...]. Word automatically gives you a caption each time you insert a particular type of object (eg for all your tables or a series of equations).

8. Complete the caption, here type Screenshoot of the Desktop.

You’ll find the caption is added to your text in a new Caption style. Using captions like this not only lets you generate a List of Figures etc but renumbers them automatically as they are moved around or as new figures are added higher up in the text.

Tip: If your caption appears in a Text Box, it’s because of the figure’s Wrap Text property. We recommend that this is set to In Line with Text. To do this, first [Undo] the insert caption then right click on the graphic and choose Wrap Text. Choose In Line with Text then repeat steps 2 to 8 as above to add the caption again.

To change the caption style:
9. Right click on Caption in the Styles pane and choose Modify...
10. Make the necessary font (size & colour) & style (bold/ italic) changes – eg to match your normal text.

It’s important that a caption should appear on the same page as the figure or table to which it refers. This is set up automatically for you by the Caption style - another advantage of using captions. Headings are also set up similarly, so that they don’t appear isolated at the bottom of a page.

11. Next, add a caption to your table – select it by clicking on the cross which appears just above it.

12. Repeat steps 2 and 4, this time choosing the Label: Table and then press <Enter> for [OK].

13. Complete the caption by typing in some suitable words (eg Example Table).

Note: If you want a table or figure to be split into several sections (eg Table 1a, Table 1b, Table 1c etc) then you have to edit the field code generated for you by the caption style. To do this:

i) For the first table/figure, simply add the letter a manually.
ii) For the second table/figure, select the caption numbering, right click and choose Toggle Field Codes.
iii) Change the final code from {SEQ Table \* ARABIC} to read {SEQ Table \* ARABIC \c}.
iv) Right click again and choose Update Field then type in b or c etc manually.

The \c code picks up the previous table/figure’s numbering. You can, if you want, set the number explicitly using \r x where x stands for the number required.

Cross-Referencing

Using captions to label your figures and tables has another advantage - you can refer to them using a cross-reference in your text. These cross-references update automatically to match the figure/table number if its numbering changes. You can also cross-reference footnotes and numbered items (such as headings).

To add a cross-reference:
1. Press <up_arrow> then <End> (to move to the end of the paragraph above the table).
2. Click on [Cross-reference] in the Captions group on the REFERENCES tab (this button is also available in the Links group on the INSERT tab) – a dialog box appears:
The default is to cross-reference numbered items (eg section headings). For further options:

3. Change the Reference type: to the type of caption required - eg Table (note also Footnote)
4. Select the table you wish to cross-reference (here, you only have the one to choose from)
5. Change Insert reference to: to the format required - eg Only label and number

The Include above/below option is greyed out but you can cross-reference it (or a page number) as in step 5.

6. Press <Enter> for [Insert] then <Esc> to [Close] the Cross-reference window
7. Continue with the text: shows a summary of . . .
8. End by pressing <Ctrl s> to save your work

The table is referred to by a special field code. Sadly the text doesn't update straightaway if another table is added before the referenced one (or if the table is moved to a different position in the text). To manually update a field code, right click on the text and choose Update Field... from the pop-up menu. The easiest way to update all your cross-references in one go is to Print Preview your work (via Print on the FILE tab).

**Tip:** To cross-reference other pieces of text, select the text and then move to the INSERT tab and select [Bookmark]. Supply a name for the bookmark then click on [Add]. To cross reference this text, repeat steps 2 to 6, as above, but at step 3 choose Bookmark and at step 5 the required format.

**The Navigation Pane**

The Navigation Pane is a very simple, yet immensely useful, tool for moving around your document. You may have noticed that the pane (displayed on the left of the screen) contains all your headings. You simply click on the required heading in the pane to move directly to it:

1. If the pane isn't displayed, move to the VIEW tab and click on [Navigation Pane]
2. Click on any of the headings to move directly to that section

You can modify the number of headings shown in the Navigation Pane by clicking on the small arrow to the left of a heading. Click on this again to reshow the headings in that section.

The Navigation Pane can also display Thumbnails - for moving around your thesis (and checking page layout):

3. Click on [Pages] – page miniatures appear
4. Click on any miniature to move directly to that page

One further feature lets you jump between figures, tables or equations (sadly, it doesn't work for your own captions such as Photographs or Maps). To see this:

5. Click on the [Magnifier] button (at the top, after Search Document) and choose tables or graphics
6. Use the [Previous ▲] / [Next ▼] buttons to move between the figures (here you only have one)
Creating Further Chapters

Let’s assume that your first chapter is now complete and that you want to start another:

1. First, save your document again but, this time, as a different file – go to the FILE tab and choose Save As
2. Choose the Thesis folder then change the File Name to Master (or something similar) – press <Enter> for [Save]
3. Next, select all the text (press <Ctrl a>) and <Delete> it
4. Double click on the word Introduction in the Header and type Chapter Title instead
5. Now, press <Ctrl s> to save your empty Master document
6. Press <Ctrl F4> (or move to the FILE tab and choose Close) to close your document

Though it took a lot of effort to set up your first chapter, it’s very easy to create a new file using all the settings which are also stored in the Master file. The alternative would be to set up each file individually, as you create it, which is very time-consuming and can easily lead to inconsistencies. To create a new file:

1. Move to the FILE tab then right click on Master in Recent Documents and choose Open a Copy

A new document will appear with the settings from the Master.

2. Click on [Heading 1] in the Styles pane – Chapter 1 appears
3. Click on the list arrow attached to the right of the [Numbering] button in the Paragraph group on the HOME tab and choose Set Numbering Value...
4. Change Set value to: to 2 then press <Enter> for [OK] – subsequent numbering of headings and captions (if you include the chapter number) make use of this value
5. Type the title for your new chapter (eg Literature Review) then press <Enter>
6. Click three times on the words Chapter Title in the header and replace them with the title of your new chapter
7. Double click anywhere in the main body of the text or click on the [Close Header and Footer] button

You would now continue writing your new chapter but, here:

8. Close Word - press <Alt F4> or click on the red [Close] button - save the new file as Chapter2

Once you have written some or all of your thesis, work through the second part of these notes - Microsoft Word 2013: Finishing a Thesis. The following sections may be useful to some users only.

Using a Special Template

If you are an experienced user, you could consider setting up a special template for your thesis work. Though this is the proper way of working, we do not recommend it for the average user. It can create problems if not used correctly, especially if the user is editing files on more than one PC.

A template is a file which holds a host of settings, which are used when you open a document based on that template. The default template is called normal.dotx but you can create your own very easily. To save your current settings in a template:

1. Set up your styles (normal, heading, caption, header/footer etc), page numbering, page layout etc (as detailed in pages 2 to 10 of this document
2. Select all the text in your file (press <Ctrl a>) and Cut it (press <Ctrl x>)
3. Save the empty file as a template – from the FILE tab, choose Save As
4. Change Save as type: to Word Template (*.dotx) and supply a File name: (eg mythesis) for your template, saving it in your thesis folder - press <Enter> for [Save]

To use the template to create a new file:
5. **Double click** on the template file (or a shortcut to it, placed on the Desktop) then you’ll get a new document with all the template settings – continue from step 2 in the previous section.

If you find you need to alter the template in the future, you can always reopen this template file from within Word and make the necessary changes. However, you can also redefine or create a style from within a document and add this to the template. To do this:

1. When creating or modifying the style, simply turn on the check box which says **New documents based on this template** (instead of the default *Only in this document*)
2. Save the changes (press <Ctrl s>) both to the document and template when prompted

### Adding References

You’ve almost completed the *Starting a Thesis* training now, but some of you might like to see how the *EndNote* software can be used for managing your references. As you type in your thesis, you will be including references in your text. Word has its own referencing system (see *Microsoft Word 2013: Managing References*), but this isn’t really adequate enough for a thesis. Instead you should be using the special bibliographic database program *EndNote*. Note, however, that if you use Microsoft’s referencing system, the references can be transferred to EndNote, if you subsequently use that.

As you do your research, you can use *EndNote* to build up your own library of references (either by typing them in or by downloading them from the University’s *Unicorn* or other library catalogues). You then use this to add references and, simultaneously, create a bibliography at the end of your text. The Library produces written notes on using *EndNote* and gives training on it; here, you will be briefly introduced to the software.

1. Load up *Word* and open the *Chapter One* file – move to the **FILE** tab and select it from the list of **Recent Documents** on the right
2. Move to the **ENDNOTE** tab then click on the **[Go to EndNote]** button
3. (You may need to close 3 Endnote windows) Click on the **File** menu in EndNote and choose **New**
4. The **New Reference Library** window appears - type in a **File name** (eg. *refs*) and change **Save in**: to point to your **Thesis** folder (*double click on Thesis* to **[Open]** it)
5. Click on [**Save**] to create the new library - the following window appears:

You could now start typing in your references by hand (by clicking on the green + [**New Reference**] button or using **New Reference** from the **References** menu or you can download them from a library catalogue. You have to be a little careful here or you can accidentally download hundreds of references into your own library.

**Tip:** When typing in a new reference for an organisation such as *United Nations*, add a comma at the end of the organisation to prevent *EndNote* referencing it as *Nations, U.*)
In EndNote there are 3 ways of working (with buttons in the order of Local Library Mode, Online Search Mode, and Integrated Library & Online Search Mode):

6. Begin by moving to **Online Search Mode** – click on the [Online Search Mode] button (in Integrated mode, all references are automatically copied into your own library)

7. Next, click on **Online Search** (the magnifier in the middle of the toolbar) or open the EndNote **Tools** menu and choose **Online Search** – the Choose a Connection window appears:

![Choose a Connection window](image)

8. Choose **U Reading** (scroll down, if necessary) then press **<Enter>** for **[Choose]**

You are now linked to the University’s Library catalogue, with a search screen waiting to be filled in. You can set your own search criteria if you prefer not to use the example below.

9. In the first box, change **Author** to **Keywords**, leave Contains as it is but type **Computer Training** in the third box - click on **[Search]**

10. A window saying how many references have been found appears - press **<Enter>** for **[OK]**

The matching references are now returned to your screen. If you need to, you can refine the search by changing the online search criteria or you can perform a completely new one. With each new search, the default is for the current list to be cleared.

Having listed the possible references, it’s time to copy the ones you want into your personal library.

11. Click on the reference required (here, click on any reference then press **<Ctrl a>** to select them all)

Note that you can also use **Ctrl click** to select several individual references or **Shift click** to select a range.

12. Now open the **References** menu, choose **Copy References to...** then select **refs.enl** - the references are copied into your own library

13. Click on the **[Local Library Mode]** button

Now start adding references to your thesis:

14. Click on your document (or on the **[Return to Word Processor]** button) to move back to Word then press **<Ctrl End>** to move to the end of your text

15. Type in some more text (any rubbish will do) then click on the **[GoTo EndNote]** button

16. Select the required reference then click on the **[Insert Citation]** (red arrow) button (or use **Insert Selected Citation(s)** under **Cite While You Write** in the **Tools** menu, or simply press **<Alt 2>**)
You’ll find the selected reference is added to your thesis, both in the usual abbreviated form in the text and in full below it. EndNote adds special codes to your document, which translate into the reference. You can see these codes by right clicking on a reference and choosing Toggle Field Codes. Repeat this to return to normal.

17. Repeat steps 15 and 16 to add two further references - you’ll find the list below the text is automatically sorted into alphabetical order.

18. Repeat steps 15 and 16 again but choose one of the references you already have in your text - you’ll find the abbreviation is added to the text but only one entry appears in full.

19. Finally, locate a unique reference, drag through it to select it then press <Delete> - the full reference will disappear automatically from the list below.

Sometimes you want to include a reference in a different format, for example: Smith (2008) says … To do this:

20. Right click on any reference and choose Edit Citation(s) then Display as Author (Year).

The full reference is retained in your list of references. If you want to add extra text (eg page numbers):

21. Right click on the reference and choose Edit Citation(s) then More …

22. Include the extra text in the Prefix: or Suffix: box (don’t be tempted by Pages:)

23. Finally, press <Enter> for [OK] to close the dialog box.

TIP: To format your references with a hanging indent, move the typing position to immediately below your references; click on the [Format Painter] button then drag through your reference list (the empty paragraph has the required settings).

EndNote is a really useful tool when writing a thesis. It ensures you have a complete reference list building up as you write your text, with all references cited included (and no duplication). To learn more about it, including different referencing styles such as Harvard, ask at the Library Information Desk.

Note: You can purchase a copy of the software, at a special education rate, to install on your own PC. You can then take a copy of your refs.enl file (from the thesis folder in My Documents) to put on your own PC and can add new references at any time. Note that there’s also a free version of EndNote called EndNote Web.

Most people don’t bother buying the software; they simply use the University system for adding references. These will then be displayed using the special codes generated by EndNote.

24. End by closing Word in the usual way, saving the changes made to your file.

25. Also close EndNote - press <Enter> for [OK] to discard any unused references from the library search and ignore any error messages which might appear.

Further Help and Tips

The following tips are worth noting:

- To get a copy of information from a web page, use the [Screenshot] button, as covered earlier. Use the [Crop] button on the PICTURE TOOLS FORMAT tab to remove any unwanted areas. Finally, enlarge or shrink it by dragging out a corner handle. Note that if you enlarge it too much, you may lose picture quality.

- Be aware of the typing area (indicated by white on the ruler, if you have it displayed). Don’t be tempted to place text, a table or graphic so that it stretches outside this area into the margins.

- To insert a special character, move to the INSERT tab, click on [Symbol] then choose More Symbols…. Select the Font: then double click on the required character. If you set the Font: to (normal text) then the character appears in the font being used at that time.

- When you run the spelling/grammar checker, Word notes which passages of text have been checked. In order to rerun the checker from scratch, move to the FILE tab then click on Options at the bottom. Move to the PROOFING tab then click on the [Recheck Document] button. You can now run the spell checker again to check the whole document.
When writing your thesis you should be aware of the number of words you are using. Remember that the total length should not exceed 90,000 words (for a PhD) or 60,000 (for an MPhil). It’s a good idea to monitor your word count as you write each chapter, though you could leave this until all the chapters are written.

Word automatically shows a word count on the Status Bar (bottom left of the window). If this isn’t showing:

1. Right click on the Status Bar
2. Turn on Word Count – note the other options (Section might also usefully be added)

Don’t forget that Word has a comprehensive on-line help facility. This is available via the [Help] button. Various guides to Microsoft Word 2013: Advanced Topics are also available on the WWW.